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EXPLORE 
 

● Play in the sandbox 
 To determine whether Omeka is right for your project, take some time to play in the  

public sandbox. You will not be able to test themes or plugins here, but you will get a 
basic sense of the admin dashboard and can practice uploading items, outfitting them 
with Dublin Core metadata, and assigning them to collections.    
 

● Check out examples 
Take a look at the Omeka-powered site showcase and the more comprehensive, user-
generated site codex. Note that some of the more highly designed examples (e.g. The 
Peacock Room) involved extensive coding above and beyond Omeka’s built-in and 
plugin capacities.  
 
Some of the models we found useful: BridgesNYC Postcards and Gothic Past   
 

● Review resources 
Start with Omeka’s documentation on project planning and basic admin. We found that 
Omeka’s user-generated forums become increasingly difficult to navigate as projects 
progress - for nitty-gritty, technical solutions we relied on google searches and guides 
produced by other universities.  
 

http://omeka.org/codex/Try_Omeka_Before_Installing
http://omeka.org/showcase/
http://omeka.org/codex/Sites_Using_Omeka
http://peacockroom.wayne.edu/
http://peacockroom.wayne.edu/
http://bridgesnyc.com/postcards/
http://gothicpast.com/
http://omeka.org/codex/Documentation


 
 

INSTALL 
 

● Download Omeka.org site  
The Collaboratory uses an external hosting service called BlueHost. Once your Omeka 
project is confirmed, ask Quint to outfit you with an instance of Omeka.org on BlueHost 
and provide him with a site title, username, and password. Tip: Omeka also allows you 
to host a free, somewhat curtailed version at Omeka.net.  
  

● Pick a theme 
Customize the look and functionality of your Omeka site by selecting a theme. Your site 
will come preloaded with a few default themes, including Thanks, Roy! (a simple, 
serviceable theme that we recommend for its relative elegance and easy customization). 
Review a full array of options on Omeka’s Themes page.  
 
Send a list of themes you would like to test to Quint for download and installation.  
 
Access and configure your themes on the “Appearance” page linked in the top 
navigation bar of your dashboard.  
 

 
 
>Tip: We tested Griddy, Seasons, Berlin, Minimalist, Dark, and Thanks, Roy. We 
immediately ruled out Griddy and Dark due to glitchiness. Seasons was aesthetically 
untenable. Berlin and Minimalist were functional and relatively attractive but both less 
aesthetically neutral than Thanks, Roy. We selected Thanks, Roy because of its simple 
layout and fonts, customizable banner and masthead, and technical stability.  
 
 

http://omeka.org/codex/Org_vs_Net
http://omeka.org/add-ons/themes/


 
>Tip:  Quick Guide to Configuring THANKS, ROY 
Customize your text and buttons colors, web banner (image at top of page), and 
masthead (title graphic) by visiting Appearance > Configure Theme 
 

 
 
 
You will arrive at the Appearance > Themes page where you can customize your sites 
colors, header and footer, homepage features, and item display (these categories apply 
only to Thanks, Roy; customization options will differ in other themes).  
 
 
Note that the Appearance > Themes page offers a sub-navigation bar to customize 
Themes (design), Navigation (site map), and Settings (image derivative sizes and 
display settings).   
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Start by configuring design on the Appearance > Themes page: 
 

• Provide a hex code to set the color of different elements of the theme 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

● Design your site’s header (or masthead banner) in two parts. 
 

 

Header 
Background 

(image) 
Logo File  

(text/title graphic) 



 
 

1. Upload your title graphic as ‘Logo File’  
>Tip: Prepare your title graphic in Photoshop on a transparent canvas that is 
150 pixels high by a maximum of 970 pixels wide. Export as a .GIF file. 
Upload to Omeka.    
>Tip: You can opt not to upload a ‘Logo File.’ Your site title will appear in its 
place. 
 

2.   Upload your banner as ‘Header Background’  
      >Tip: Prepare your banner in Photoshop on a canvas that is 250 pixels high  
      by 970 pixels wide. Export as a .JPEG file. Upload to Omeka.  
      >Tip: ‘Logo File’ dimensions affect ‘Header Background’ dimensions.  
 

● Identify plugins 
Task-specific plugins are essential to a serviceable Omeka site. Plugins are developed 
by users to meet specific project needs. Read about Omeka-endorsed plugins, and 
select those most relevant to your project.  
 
Send a list of plugins you would like to test to Quint for download.  
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http://omeka.org/add-ons/plugins/


Access and configure your plugins on the “Plugins” page linked in the top navigation bar 
of your dashboard.  
 

 
 
You will see the plugins downloaded to your site listed on this page. Click Install and 
then Configure (not all plugins allow you to configure them).  
>Tip: Take your time. Installing a long list of new plugins all at once can crash your site. 
 

 
 
Once the plugin is installed, it will usually appear as a new button on your left navigation 
beneath the default navigation (Dashboard, Items, Collections, Item Types, Tags).  
 
In a few cases, the plugin does not appear in the left navigation. Its functionality instead 
becomes apparent in the Plugins > Configure settings (e.g. Hide Elements) or on Item 
pages (e.g. DocsViewer, Social Bookmarking).  



>Tip:  Quick Guide to Plugins  
 
BEST   WORST  USEFUL       WORTH A TRY 
Simple Pages  Image Resize  DocsViewer      LOC Suggest  
Exhibit Builder  Shortcode Carousel Hide Elements      SharedShelf Link 
CSV Import     Dropbox 
Neatline (w/ Waypoints + Simile)  Social Bookmarking 
 
>>Tip:  Plugins are frequently released and re-released. Check back often, and be sure 
you’re operating in the latest version of Omeka and its plugins.  
 
>>WORST  
 

• Image Resize: This plugin repeatedly crashed our site.  
 

• Shortcode Carousel: The code is faulty and allows very limited customization.   
 
>>BEST  
 

• Neatline (+Neatline Waypoints, +NeatlineSIMILE): Adds a digital map-making 
environment that makes it easy to represent geospatial information as a 
collection of “records” plotted on a map or still image. You can bind these 
together into interactive exhibits with timelines and sequences to tell stories and 
make arguments. 
>Tip: Scroll down to the Guide to Neatline Plugin, Guide to Neatline’s 
Waypoints, and Guide to Neatline’s SIMILE Timeline sections of this guide. 
>Tip: Review Haverford’s Neatline Starter Site and Duke University’s Neatline 
Guide. 

 
• Simple Pages: Allows you to design simple web pages for your public site. 

Simple Pages can be created and edited in HTML, allowing for images, links, 
formatted text, embedded slideshows, and videos.  
>Tip: To customize your homepage, build it as a Simple Page. Visit Appearance 
> Navigation. Select your page from the “Select a Homepage” dropdown menu at 
right.  

 
• Exhibit Builder: This is your primary tool for building rich displays and 

interpretations of your items. Note that you cannot add items to more than one 
Collection; Exhibit Builder is the best way to present an item as part of multiple 
themes or groupings. 
>Tip: The basic Exhibit landing page is very simple and cannot be customized in 
html. As you add pages to your exhibit, however, you will be able to select from 
three layout blocks (file with text, gallery, or text) and add as many layout blocks 
as you like to each page.  

http://omeka.org/codex/Plugins/ImageResize
http://omeka.org/add-ons/plugins/shortcode-carousel/
http://omeka.org/add-ons/plugins/neatline/
http://ds.haverford.edu/omeka-starter/neatline/show/neatline-tutorial
http://dukewired.org/tutorialFiles/NeatlineManual.pdf
http://dukewired.org/tutorialFiles/NeatlineManual.pdf
http://omeka.org/add-ons/plugins/simple-pages/
http://omeka.org/codex/Plugins/ExhibitBuilder_3.0


 >Tip: Scroll down to the Exhibit Builder section of this guide. 
• CSV Import: Allows administrators to import items from a simple CSV (comma 

separated value) file, and then map the CSV column data to multiple elements, 
files, and/or tags. Each row in the file represents metadata for a single item. 
>Tip: When using this plugin, you may only import one item type (document, still 
image, sound, et al) at a time. You may perform multiple imports. 
>Tip: If you specify permanent file URLs in a column, the importer will download 
and attach a file to each created item 
>Tip: Watch tutorials on preparing for CSV import and importing CSV files, 
review the Haverford CSV Import Tutorial, and scroll down to the CSV Import 
Quick Guide below. 
>Tip: Don’t know what CSV is? Some useful links: 
http://en.wikipedia.org/wiki/Comma-separated_values 
http://data.okfn.org/doc/csv 

 
>>USEFUL  
 

• Docs Viewer: Embeds a Google document viewer into item show pages. PDF 
documents, PowerPoint presentations, TIFF files, and some Microsoft Word 
documents are supported. 

 
• Hide Elements: This plugin lets administrators choose metadata elements to 

hide. Elements can separately be hidden from the edit form, display on the admin 
side, display on the public side, and the search form.  
>Tip: The elements will be suppressed universally across your Omeka site and 
plugins.  

 
• Dropbox: Use the Dropbox plugin to quickly add many items to your Omeka site, 

rather than uploading files individually. This plugin is not affiliated with the 
Dropbox file storage service.  
>Tip: If the files you wish to upload as items to Omeka exist on the web with a 
stable URL, we recommend skipping Dropbox and including them as a column in 
your CSV Import. Using CSV Import will automatically associate each file with 
relevant metadata, a major time saver.  
>Tip: To be available to the Dropbox plugin, files must first be uploaded to a 
server FTP by an admin (i.e. Quint) 

 
• Social Bookmarking: Inserts a customizable list of social networking sites below 

each item or collection in your Omeka database. 
 
>>WORTH A TRY (Caveat: we have not tested these plugins.) 
 

• Shared Shelf Link: Allows Shared Shelf users to bulk publish image files and 
associated metadata to collections in Omeka, also creating unique items in the 

http://omeka.org/codex/Plugins/CSV_Import_2.0
http://omeka.org/files/movies/CSVImport1_1.0.mov
http://omeka.org/files/movies/CSVImport2_1.0.mov
http://ds.haverford.edu/omeka-starter/collections/show/14
http://en.wikipedia.org/wiki/Comma-separated_values
http://data.okfn.org/doc/csv
http://data.okfn.org/doc/csv
http://omeka.org/codex/Plugins/DocsViewer_2.0
http://omeka.org/add-ons/plugins/hide-elements/
http://omeka.org/codex/Plugins/Dropbox_2.0
http://omeka.org/codex/Plugins/SocialBookmarking_2.0
http://omeka.org/add-ons/plugins/shared-shelf-link/


archive for each file. Utilizing tools in Shared Shelf, a cloud-based image 
management platform created by ARTstor, metadata is mapped to Dublin Core 
from customizable schemas before publishing from Shared Shelf projects to an 
Omeka instance. 

 
• Library of Congress Suggest: An autosuggest feature for Omeka metadata 

elements using the Library of Congress Authorities and Vocabularies service 
(http://id.loc.gov) 

  
ITEMS + COLLECTIONS 
 
Omeka is essentially a collections database management system (like a free version of The 
Museum System or Mimsy XG used by registrars in major museums). Omeka is best suited to 
projects dealing with objects—works of art or archival documents, for example—and their 
metadata (an expanded and more systematic version of ‘tombstone’ information about an 
artwork customarily listed in exhibition checklists and museum wall labels). 
 
Omeka classifies each object as an ‘Item.’  
 
Access and edit your Items in the left navigation bar of your dashboard:  
 

 
 
Click the green ‘Add an Item’ button to add an Item. 
>tip: Avoid adding items one-by-one with the CSV Import and/or Dropbox bulk file uploader. 
 
 
 
 
 
 
 

http://omeka.org/codex/Plugins/Library_of_Congress_Suggest_2.0
http://id.loc.gov/
http://www.gallerysystems.com/tms
http://www.gallerysystems.com/tms
http://www.selagodesign.com/portfolio/mimsyxg/index.php


Each Item record includes a sub-navigation bar, linking to forms for inputting that object’s: 
 
• metadata following the Dublin Core standard (Dublin Core elements include title, subject, 

description, creator, source, publisher, date, contributor, rights, relation, format, language, 
type, identifier, coverage) 
>tip: Read the CSV Import Quick Guide below for further details. 
 

• type (e.g. Still Image, Text, Moving Image) and type-specific metadata (for still images these 
include ‘original format’ and ‘physical dimensions’ aka ‘medium’ and ‘dimensions’ in art 
historical parlance) 
 

• files (e.g. JPEG of the artwork, PDF of the text document) 
>tip: each Item can include multiple files (e.g. if your Item is a painting, you might include an 
image of that painting along with scans of its commission records)  
>tip: Though Omeka accepts files up to 50 MB in size, we find it inhospitable to TIFF files. 
Optimize your workflow by preparing JPEG files for all images you wish to upload to Omeka. 
 

• tags (searchable keywords) 
 

 
 
Items can be grouped into existing Collections using the dropdown menu at right.  
>tip: Each item can be affiliated with one and only one Collection. The Items/Collections 
relationship follows the same logic as a physical object that can only exist in one place at a time. 
>tip: Use the Exhibit Builder plugin for more flexible and visually-interesting Item groupings.  
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4 Check this box to set your item as 
Public in order to make it 
available in Exhibit Builder and on 
your public site. You can also 
choose to feature it (depending 
on homepage preferences).  



Access and edit your Collections in the left navigation bar of your dashboard: 
 

 
  
Click the green ‘Add a Collection’ button to add a Collection. 
 
 
DUBLIN CORE, CSV, AND UPLOADING ITEMS IN BULK 
 
If you have selected Omeka as the best platform for your project, you are more than likely 
planning to host, interpret, and present a collection of artworks and/or archival materials.  
 
You can save valuable time by preparing your Items—including files and metadata—as a 
spreadsheet, and uploading them all at once using the CSV Import plugin. 
 
It may be helpful to begin by familiarizing yourself with the basics of CSV (comma separated 
values) and of the Dublin Core metadata standard (and related vocabularies): 
 
• CSV on Wikipedia, CSV on Data.OKFN.org 

 
• Dublin Core data standards, terms, and definitions 

 
• Getty Vocabularies + Library of Congress Subject Headings 

Standards used to populate fields like "Subject" and "Coverage" in Dublin Core 
 
Dublin Core is a widely used, standardized (yet relatively flexible) system for describing a 
resource or record with a set of defined attributes or elements.  
 
Omeka integrates the Dublin Core standard, allowing you to define each Item in terms of the 
following elements: title, subject, description, creator, source, publisher, date, contributor, rights, 
relation, format, language, type, identifier, coverage   
 

http://en.wikipedia.org/wiki/Comma-separated_values
http://data.okfn.org/doc/csv
http://dublincore.org/documents/dcmi-terms/
http://www.getty.edu/research/tools/vocabularies/
http://www.loc.gov/aba/cataloging/subject/


Each element can be interpreted variously. Read Omeka’s suggestions, and think about which 
elements are important to your project. We recommend being as comprehensive as possible.  
>tip: For an Omeka site featuring a collection of artworks, we developed a checklist of artworks 
according to the Dublin Core standard interpreted as follows: 
 
• title – artwork title 
• subject – we selected the most appropriate string of terms related to our project’s 

chronology, geography, and topic from the Library of Congress Subject Headings (in our 
case: “Arts, Latin American--20th century”) 

• description – we included brief interpretive entries for select Items (leaving the rest blank)  
• creator – artist name (with consistent syntax, e.g. “Last name, First name”) 
• source – citation for the publication from which the image reproduction is sourced, in our 

case a museum website 
• publisher – we left this field blank 
• date – creation date of artwork 
• contributor – we left this field blank 
• rights  – credit line for image/artwork, including copyright, collection, and donor information 
• relation  – our project grouped artworks in terms of four themes, each defined by a 

keyword, with which we populated this field 
• format  – file format, in our case mostly JPEGs 
• language  – we left this field blank 
• type – choose from Omeka’s Item Types, in our case mostly Still Images 
• identifier – we left this blank 
• coverage – nation where artwork was created  

 
CSV (comma separate values) refers to a tabular, text-based (and very useful) way of 
organizing and storing information. Imagine a simple spreadsheet in which each row represents 
a single record (an Item or an object on Omeka) and each column represents a discrete type of 
information in that record. Where an element of information is not available (or of interest) for a 
particular record, that cell is simply left blank. 
>Tip: Each column must have the same number of rows and each row must have the same 
number of columns (in other words, do not split or merge cells).    
>Tip: Right-click your .CSV file and open it in Notepad to see the plaintext .CSV syntax.  
 
CSV Import Quick Guide 
• Compile a spreadsheet in Excel (or spreadsheet software of your choice) with a row for each 

of your Items and a column for each Dublin Core informational element. Save as a .CSV file. 
(download CSV basic template) 
>Tip: Build separate spreadsheets for each Item Type.   
>Tip: CSV preparation guides on the web will typically instruct you to place quotation 
marks around any field containing commas (e.g. a title such as, “Étant donnés (Given: 1 
The Waterfall, 2. The Illuminating Gas, French: Étant donnés: 1° la chute d'eau / 2° le gaz 

http://omeka.org/codex/Working_with_Dublin_Core
http://www.loc.gov/aba/cataloging/subject/
http://omeka.org/codex/Managing_Item_Types


d'éclairage)”). This step is not necessary with Omeka’s CSV Import plugin and will result in 
unwanted quotation marks in your data.  
 
o FILE URLS: If your files exist online with a stable URL, the CSV Import plugin will 

download them and attach them to Items in Omeka, mapped to affiliated metadata. 
Include an additional column in your spreadsheet for each file you wish to upload to 
your records. Populate this column with the file’s URL.  
>Tip: If your files do not exist online, upload them in bulk using the Dropbox plugin (with 
Quint’s help). Each Item’s “File Metadata,” visible at right on the Item’s public page, can 
serve as a stable URL in your CSV Import. After the CSV Import uploads the file and its 
associated metadata, you can delete the Items uploaded (without metadata) via 
Dropbox.   
 

o TYPE-SPECIFIC FIELDS: Each Item Type generates additional data fields in Omeka, 
which you can also include as columns in your CSV Import. Still Images, for example, 
offer fields for ‘original format’ and ‘physical dimensions,’ Include a separate column for 
each of these fields. (download CSV Still Image template)  
 

o TAGS: You can bulk upload tags to your Items using the CSV Import plugin, as well. 
Simply include a column with tag words separated by commas.  

 
• Click ‘CSV Import’ in the left navigation of your dashboard. On the CSV Import page, click 

‘Choose File’ and select your .CSV spreadsheet for upload. Check the box to ‘Automap 
Column Names to Elements.’ Choose your Item Type from the dropdown menu. Click the 
box to make all Items public. Click the green ‘Next’ button. 
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>tip: If an error message appears indicating that import settings have expired, you may be 
experiencing a browser issue (try Firefox instead of Chrome). Symbols (e.g. ©, │) and 
foreign language accents (e.g. ñ, á) in your data can also cause this issue; deleting the 
accents from your spreadsheet and manually reentering them to Omeka Items pages is our 
imperfect solution.   
 

• Next, each column from your spreadsheet will appear in a list, which you can map to a 
Dublin Core element or define as a tag or file.  
 

  
• Click the green ‘Import CSV File’ button, and refresh the status page until it indicates the 

import is complete.  

Use the ‘Tags?’ 
and ‘Files?’ 
checkboxes to 
map your tags 
and permanent 
file URLS. For 
these columns, 
do not select 
an element 
from the ‘Map 
to Element’ 
dropdown 
menu. 

Match each 
Dublin Core 
element to the 
appropriate 
element from 
the ‘Map to 
Element’ 
dropdown 
menu. Check 
the ‘Use 
HTML?’ box to 
enable custom 
formatting on 
your Item 
pages.     



>tip: Delete items from an import en masse by clicking ‘Undo Import’ on the status page. 
 
EXHIBIT BUILDER 
 
Once you have uploaded your Items and mapped their metadata, you are ready to build an 
exhibit. Click ‘Exhibits’ on the left navigation of your dashboard, and then the green ‘Add an 
Exhibit’ button.  
 

 
 
● On the Add Exhibit page, define your exhibit’s metadata, including title, slug (the name of 

the keyword segment for this page’s URL), credits, description, and tags. You can select a 
different theme for your Exhibit than for your overall Omeka site, though we recommend 
keeping the ‘Current Public Theme.’ 
 

● Adding Pages to your Exhibit is where the magic happens. Exhibit pages are attractive and 
customizable. Click the green ‘Add Page’ button, and you will find that you have three 
layout choices for your content blocks: 

○ gallery of thumbnails with optional captions 
*adding a text block forces the thumbnails into a two-column, vertical format 
*if you want your gallery to fill the entire width of the page, leave text box blank and 
toggle to ‘layout options’ to select “no showcase file’ 

○ file with text allows you to feature a single image alongside text 
*toggle to ‘layout options’ to align the image left or right and to display it thumbnail, 
square, or full size 

○ text only  
 

● Each page can be built out of multiple layout blocks. Select your preferred layout, then 
click the green ‘Add new content block’ button. Add items, captions, text, and configure 
layout options per your preferences. Save your changes using the green ‘Save’ button at 
upper right. Scroll to the bottom of the page and begin again by selecting another layout. 
Drag and drop the layout blocks into any order.  
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● The Exhibit landing page is fairly static as it cannot be designed in HTML. It also requires 

the user to click through multiple pages before accessing the meat of the Exhibit. We 
recommend building an Exhibit landing page using the Simple Pages plugin with embedded 
links to the Exhibit Builder sub-pages. You can suppress the Exhibit Builder default page in 
the site navigation and replace it with your custom Simple Page.    
 

SITE NAVIGATION 
 
Visit the Appearance > Navigation page to customize the navigation for your public page. Items, 
Collections, and About pages, as well as any custom pages you build with Simple Pages or 
Neatline will appear in a list.  
 
• Use the checkbox next to the page name to suppress or include it in your public navigation 

 
• Click the arrow beside each page name to expand a form in which you can customize the 

page’s label and slug 
 
• Drag and drop the pages into your preferred order 

 
• Select a homepage from the dropdown menu at right (we recommend building a custom 

homepage in Simple Pages)  
 
• Be sure to save your changes with the green ‘Save Changes’ button!  
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SIMPLE PAGES 
Simple Pages is an easy-to-use plugin that allows you to build custom pages within Omeka.  It’s 
a great and easy option for text-only pages, but is also relatively simple to customize, adjust 
formatting and add things like images and links. It’s especially good for creating custom 
homepages. 
 
First, you’ll need to install and activate the Simple Pages plugin. It will then appear on your 
dashboard sidebar. 

 
 

 
 
Enter Simple Pages, and create a new page by clicking on “Add a Page.” In the future, click 
“Edit” below the page name to add to your page. 

 
 
 
 
 
 



You will need to enter a name for your page (which will automatically be written at the top of 
your simple page) and a slug (which will follow “omeka” in the site URL). Click “Save 
Changes” to create the site. 

 
 
At the most basic, you can add just plain text to your page, by adding it to the text box.  

 
To do anything more than plain text, you will need to enable the HTML editor, by checking that 
box. This allows you to do standard functions like bold, italics, underline, paragraph spacing and 
alignment, and more.   
 



 
You can also easily add images this way, by clicking on the button that resembles a tree (noted 
above). In the “Insert/Edit Image” window, you need to add an image URL. You cannot upload 
a file—it has to be an image already online. Be sure to select an image that is not likely to be 
removed. It can, however, be something you are already hosting on Omeka, such as an image 
stored as an item. You do not need to fill in the other boxes, although you might want to. 
 

   
You can either input specific dimensions, or manually change the size by dragging the corners. 
 



 
 
 
When you are done, save the page.  You can get to the public version of the page by either 
hitting “View Public Page” under the “Save” button, or clicking on the page’s name (ex. 
About) under the Simple Pages list. 

     
 
 
 
 
 
 
 
 



You will also need to make your page accessible. To do this, go to “Appearance” and 
“Navigation.” 

  
 
 
Here you will find all the page links that appear in your Omeka page’s navigation sidebar (or 
possibly tabs, depending on what theme you are using). You can drag them into whatever order 
you want, and can indent them if you want certain pages to nest under another, like below. 

   
 
 
 
 
 
 
 



You will need to create a new entry for your simple page. Under “Add a Link to the 
Navigation” at the bottom, add a label and URL. The label will appear in the navigation 
sidebar. It doesn’t have to be the same as the page, but it is a good idea. The URL is the slug 
you made when you created the page. You can put the entire URL, or just “/omeka/name” (as 
can be seen below). Finish by clicking “Add Link” and then minimize by clicking the small arrow 
in the upper right corner. You can now drag this page into the correct order. 

 
 
There may be pre-set pages you do not want to use. You can block any pages from showing up 
by unchecking the box on the left.  

 



You can also do a lot more with simple pages, some involving some basic HTML coding. You 
might want to do this to create a landing page that leads visitors to various aspects of your site.  
For example, the automatic organization for multiple Neatline exhibits is neither visually 
appealing nor user-friendly (see below, left), so you might want to suppress this page (by 
unchecking the box in the navigation menu, as seen above) and make a simple page with links 
that leads you to your Neatline exhibits instead (see below, right). 
 

   
 
 
In order to make a page like this, you may need to write simple HTML code.  You can use a 
blend of written code and automatic coding by editing in the text box (after inputting some code) 
to get the desired effect.  To input your code, click the HTML button. 
 

 
 
 
 
 
 
 
 
 
 
 
 



You input your code into the HTML Source Editor window. You can type directly in the box, or 
write it in another program (like Word) and paste it into the Editor. Saving (by hitting “Update”) 
will remove any spaces or paragraph breaks, so it is best to keep a saved version in Word 
where you can keep it formatted for easier use. 
 

     
 
 
 
 
 
 
Basic formatting and images can all be inserted without needing to code, and so can basic links.  
You can type a word, and then click the “Insert/Edit Link” button (that looks like a chain) to 
input the URL. You could use this to link to any of your other pages (including other Simple 
Pages or a Neatline exhibition), or to an external page.   
 

 
 
 



If you are making many similar links (for instance, a page of tags, as seen above), this can also 
be achieved with simple coding (quicker than manually adding links for every entry). The basic 
code for a link is as follows: 
 
<a href="your URL">Link Text</a> 
 
An example might look like this: 
<a 
href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=shield">shield</a> 
 
Spaces between links can either be added manually in the text box, or with the simple code 
“&nbsp;”. Thus, you could have a series of links together with a code that looks like this: 
 
<a href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=dove">dove</a>&nbsp; 
&nbsp;<a 
href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=dragon">dragon</a>&nbsp
; &nbsp;<a 
href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=eagle">eagle</a>&nbsp; 
&nbsp;<a 
href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=elegantly+dressed">elega
ntly dressed</a>&nbsp; &nbsp;<a 
href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=enclosed+garden">enclos
ed garden</a>&nbsp; &nbsp;<a 
href="http://arthistoryguide.artinterp.org/omeka/items/browse?tags=Evangelist">Evangelist</a
>&nbsp; &nbsp; 
 
 
Since these codes all have similar URLs, it is much quicker to write simple code than manually 
link every entry, by copy and pasting just one section and only changing the parts in bold above. 
Coding can also be helpful to create image links—a more visually appealing way to display lists 
of links. The code for an image link is as follows: 
<a href="destination URL" target="_blank"> <img style="border: none; max-width: 
100%;" src="image URL" alt="link name" /> </a> 
 
An example might look like this: 
<a href="http://arthistoryguide.artinterp.org/omeka/neatline/show/peter-martyr" 
target="_blank"> <img style="border: none; max-width: 100%;" 
src="http://arthistoryguide.artinterp.org/omeka/files/square_thumbnails/7d3ebfb726a2a8
cfb9b5f5362256b79d.jpg" alt="Saint Peter Martyr" /> </a> 
 
Images can be found anywhere online, but be sure to pick something that will not be removed.  
You can also use an image from your own Omeka site. Image links can be resized and 
formatted much like normal images in simple pages. 
 



You can add a border or change the width in the code, but for a plain thumbnail leave them at 
“none” and “100%”. 
 
Coding to create a thumbnail gallery is slightly more complex.  First and foremost, you will 
need a URL for a thumbnail version of your image.  One option is to use thumbnails for Omeka 
Exhibition galleries.  You can create a gallery out of Omeka items (below, left) and it will 
automatically format a page with image thumbnails (below, right).  You can then copy the 
thumbnail URL and input it into your code. 
 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Adding captions requires more complicated code. However, you can instead manually input 
captions in the textbox, and add spaces through trial and error until they line up. You can also 
use this sample code for two four-image rows of thumbnails (duplicating if necessary), filling in 
the relevant URLs and captions and adjusting the spaces as needed: 
 
<address><a href="destination URL 1" target="_blank"> <img style="border: none; max-
width: 100%;" src="thumbnail URL 1" alt="Link Name 1" /> </a>&nbsp;&nbsp;&nbsp;  
 
<address><a href="destination URL 2" target="_blank"> <img style="border: none; max-
width: 100%;" src="thumbnail URL 2" alt="Link Name 2" /> </a>&nbsp;&nbsp;&nbsp;  
 
<address><a href="destination URL 3" target="_blank"> <img style="border: none; max-
width: 100%;" src="thumbnail URL 3" alt="Link Name 3" /> </a>&nbsp;&nbsp;&nbsp;  
 
<a href="destination URL 4" target="_blank"><img style="border: none; max-width: 
100%;" src="thumbnail URL 4" alt="Link Name 4" /><br /></a> 
 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; Caption 1 &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; Caption 2 &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; Caption 3 &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; Caption 4 
&nbsp;</address><address>&nbsp;</address> 
 
<address><a href="destination URL 5" target="_blank"> <img style="border: none; max-
width: 100%;" src="thumbnail URL 5" alt="Link Name 5" /> </a>&nbsp;&nbsp;&nbsp;  
 
<address><a href="destination URL 6" target="_blank"> <img style="border: none; max-
width: 100%;" src="thumbnail URL 6" alt="Link Name 6" /> </a>&nbsp;&nbsp;&nbsp;  
 
<address><a href="destination URL 7" target="_blank"> <img style="border: none; max-
width: 100%;" src="thumbnail URL 7" alt="Link Name 7" /> </a>&nbsp;&nbsp;&nbsp;  
 
<a href="destination URL 8" target="_blank"><img style="border: none; max-width: 
100%;" src="thumbnail URL 8" alt="Link Name 8" /><br /></a> 
 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; Caption 5 &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; Caption 6 &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; Caption 7 &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; 
&nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; &nbsp; Caption 8 
&nbsp;</address><address>&nbsp;</address> 



You can add text at the top using the textbox, and will end up with something that resembles 
this: 

 
 
 
Finally, when you are finished, be sure to make your site public, by clicking the “Publish This 
Page?” box. 

 



NEATLINE 
 
The Neatline plugin offers an interpretive lens through which to understand art objects, archival 
documents, and so on. Using Neatline’s annotation tools, you can create translucent outlines 
around particularly suggestive details of the base image. As users interact with the annotations, 
they will discover related image and media files that provide supplementary details and 
interpretive clues. You can also embed long-format texts about the specific context about the 
piece you are working with. Neatline can be used to craft sophisticated and nuanced narratives 
about the objects. 
 
Some examples of the kinds of projects that lend themselves to Neatline: 
 

• A geographic and institutional map of 20th-century literary theory. We tend to identify 
clusters of literary critics with universities, cities, and countries – the Yale school, 
Russian formalism, Marxism and the Frankfurt School, etc. You want to plot the 
institutional affiliations and career arcs of ~100 prominent 20th century literary theorists, 
grouped by critical school, to explore to what extent the real-world locations and 
temporal overlaps of various critics do or do not correspond with the conceptual 
connections that emerge in their work. Use Neatline’s map and timeline features, and 
import relevant pieces of evidence into Omeka. 
 

• An in-depth look at the signatories of the Declaration of Independence. You want to 
create an interactive exhibit that “attaches” biographic information about the signatories 
on the Declaration of Independence to a high-resolution image of the actual document. 
Neatline’s annotation tools make it possible to draw precise, translucent outlines around 
the signatures on the document, and to interactively display long-format biographies and 
pictures, stored in Omeka, as your users interact with your annotations. 

 
• An interactive narrative of the early British Mount Everest expeditions. Did George 

Mallory and Andrew Irvine make it to the summit on June 8, 1924? Use contemporary 
satellite imagery, built into Neatline. as you create a map showing the climbing lines that 
the parties followed on their summit attempts, the conjectured routes that Mallory may 
have taken, and the location of his body when it was discovered in 1999. The phases of 
the climb can be plotted as spans on the timeline, and minute-by-minute accounts from 
the Odell diaries, brought into Omeka as discrete objects, can be captured as points on 
the map and timeline. 

 
• A visualization of the movements of characters and concepts in The Tempest. 

Shakespeare’s play takes place in an indeterminate aesthetic space, an island outside 
the moving world — and yet the literal, spatial movements of its characters are 
described in significant detail. You can draw and scan your own map, or import a 
Renaissance-era map of an island in the Mediterranean (or the West Indies, or the 
Caribbean) to create a speculative, playful plotting of the spatial dimension of the text — 
Prospero’s lair, the shipwreck, the carousing of Caliban and Trinculo, Ariel’s errands, 
and the journey back to Italy. 

 
Before getting started, explore visual examples of Neatline projects. Think about what kind of 
story you are telling. What is your thesis and will it be further illuminated by Neatline? Think 
critically about your methodological approach. Although Neatline can be a powerful way to 
communicate complex narratives, it may not be right for your project.  

http://neatline.org/demos/


GUIDE TO THE NEATLINE PLUGIN 
 
Click ‘Neatline’ on the left navigation of your dashboard (IMPORANT the Neatline plugin must 
be downloaded and installed before it will appear on the left menu). 

Click ‘Create an Exhibit’ (your Neatline = an exhibit). 

 
 

Title your Neatline and make it public by checking the ‘Public’ box. You might also want to fill in 
the ‘URL SLUG’ which is a unique string used to form the public-facing URL for the exhibit 
which can contain letters, numbers, and hyphens. If you want to add a description to 
accompany your Neatline, do so in the ‘Narrative’ textbox. This text will appear below the 
background image you choose for your Neatline. Click the ‘Save Exhibit’ button at the bottom of 
the page. 

 



From the dashboard, click ‘Neatline’ on the left navigation, then click your Neatline’s title. 
 

You must now decide whether you want your background image to be a still image (of a 
painting, sculpture, etc) or a map. If you chose to use a still image, you must have a stable link 
to that image. Copy the URL into the ‘Image Layer’ field and hit save.  

>tip: Add the image to Omeka as an Item and pull the URL from the Item page.  
>tip: If you wish to work with a map as your base layer, scroll down to the Neatline 
Waypoints/SIMILE section of this guide.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



In the Neatline Editor, click ‘Styles’ in the top navigation. Navigate/zoom into the map to the 
region you want your Neatline to display by default when it opens. Beneath ‘Default Map Zoom,’ 
click "Use Current Viewport as Default." Click ‘Save. 

 

 
Create a Record 
Neatline records are pop-up windows within an exhibit that can contain text, images, videos, 
event 3D models. They are accessed within the exhibit via hotspots overlaid on the map/image 
layer or timeline. You can create as many records as you’d like. 
 
In the Neatline Editor, under the Records menu, click ‘New Record.’  

 
Fill in the Title, and add some descriptive text in the Body. Click "Save". 



 
 
 
 
 
 
 
 
 
 
 

SLUG: 
The slug is a plain-text identifier for the record 
- think of it as a human-readable ID that can 
be used to reference the record from other 
locations. For example, in the Neatline Text 
plugin - which makes it possible to connect 
text documents with Neatline exhibits - 
individual words or sentences can be linked to 
Neatline records by including the record slugs 
in the HTML markup. For example, if the text 
included something like: 

<span data-neatline-
slug="paris">Paris</span> 

If you had a record in your Neatline exhibit 
with the slug ‘paris’, the "Paris" document 
would be interactively linked with the location 
on the map. The slug isn't displayed anywhere 
in the public-facing version of the exhibit - if 
you're not using the Text plugin, it fine to leave 
it blank. 

TITLE: 
The title is the text used to label 
the record in pop-up bubbles, 
on timelines, and waypoints. 
Try to keep it short and simple, 
and avoid using complex 
formatting. A title isn't required, 
but if you leave it blank you'll 
likely end up with some odd 
visual artifacts in your exhibit 
(empty preview bubbles, 
unlabeled points and spans on 
the timeline, etc). 
If you want to add special 
formatting to the title (e.g., 
make it bold, increase its size), 
click "Edit HTML" next to the 
field label to open a full-screen 
WYSWYG editor with a full 
load-out of formatting options. 
When you're done with the 
editor, click the 
Minimize button to return to the 
regular editing interface. 
 

BODY: 
The body is a catch-all field designed to 
house the main textual content for the 
record. Depending on what kind of 
content you're working with and how 
you're structuring the user-interface for 
the exhibit, you might wish  to enter 
anything from a short blurb to a 10,000-
word scholarly essay. 
As with the title, click "Edit HTML" to 
open a full-screen WYSWYG editor for 
the field. Although it's generally a good 
idea to keep the formatting pretty 
minimal for the title, it’s fine to use much 
more elaborate and structural styling in 
the body - bullets and numbered lists, 
images, tables, etc. 
You can include any kind of embeddable 
third-party multimedia content - videos 
from YouTube or Vimeo, audio from 
SoundCloud, etc. Click the "Source" 
button at top left of the editor to activate 
view-HTML mode, and paste in the 
embed code 



When you have uploaded your information in to the “Text” box, it will display as a Neatline 
hotspot like this (notice I have decided to associate an image with this entry, which will be 
explained in the next step): 

 
 

Associating an object (image, PDF, PPT, or media file) can be done easily by clicking the “Item” 
tab and selecting the object you want to add from the dropdown menu. The object must already 
exist as an Omeka Item to be attached to your Neatline entry. 

 



From the Map menu, select "Draw Point". Click the map in the location where you want to place 
the point. Click "Save". 

 
Follow these steps to lay down individual points on the map: 

• Select the "Draw Point" button, move the cursor to the location on the map where you 
want to place the point, and click down once to drop the point. 

 
• To add multiple points, click multiple times in different locations. 

>tip: Points auto-display as circles on the map, but, in the underlying data, they're 
actually represented as dimensionless pairs of lat/lon coordinates. Since they're infinitely 
small and have no measurable "size" that can be correlated to the scale of the map, the 
points will always stay the same size, regardless of the zoom level of the map. The size 
of the circles can be controlled by the "Point Radius" field in the "Style" tab. Depending 
on the situation, this default can be good or bad. For example, if you're using points in 
conjunction with the "Point Image" feature to plot thumbnails of photographs onto the 
map, you might want the points to stay the same size at different zoom levels so that the 
preview images never become too big or too small. If you want a real geometric circle 
that changes size with the zoom level, use the "Draw Regular Polygon" tool. 



 
You can also draw a specific figure using the SVG function to annotate your image. The 
standard "Draw Point/Line/Polygon" tools are good for simple, diagrammatic shapes - dots, 
rectangles, circles, simple arrows, etc. They don't scale well, however. What if you want to 
create a smooth, intricate shape? Neatline exhibits are always exercises in information design, 
and there's a class of "illustrative" annotation that doesn't fit well into the blocky aesthetic 
supported by the standard-issue GIS tools. You could painstakingly sketch complex illustrations 
using the line and polygon tools, but the resulting geometry is brittle and difficult to maintain. 
What if you decide later on that you want to change the drawing? You'd have to manually 
reposition hundreds or thousands of points. 

 
To address this problem, Neatline 2.0 introduced the "Draw SVG" tool, which makes it possible 
to create high-fidelity, easily-maintained illustrations in specialized vector editing programs 
like Adobe Illustrator or Inkscape (and even in-browser tools like SVG-Edit) and import them 

http://www.adobe.com/products/illustrator.html
http://inkscape.org/
http://svg-edit.googlecode.com/svn/branches/2.6/editor/svg-editor.html


directly into the Neatline editor. This way, you can do the difficult work of vector illustration in 
tools that are specifically designed for that task, and then drop the final products into Neatline 
exhibits. Later in, if you want to change something about the drawing, you can just go back to 
the original source file, make the change, and then update the Neatline exhibit with the new 
content. 

 
Neatline reads a commonly-used serialization format called SVG (Scalable Vector Graphics), a 
form of XML that encodes geometric information. To start, you'll need to save off your vector file 
as an SVG document. 
 
 
Generating the SVG Document: 
 
Using Adobe Illustrator: 

• Click File > Save As. 
• In the "Format" drop-down menu, select "SVG (svg)." The "SVG Options" modal should 

be displayed. 
• In the "Fonts" fieldset, set "Type" to Convert to outline. This ensures that means text 

elements in the document will be saved as raw geometric paths, not 
abstract<text> elements that can't be parsed by Neatline. 

• Click OK to save. 
 

Using Inkscape: 
• Before saving, if you have any text elements in the document, first convert them to raw 

path elements by selecting them and entering Ctrl+Shift+C (see the documentation for 
more information.) 

• Click File > Save As. 
• In the dropdown menu for the format, select Plain SVG. 
• Click Save. 

 
Importing the SVG into Neatline 
 
Once the SVG document is saved, we can import it into Neatline: 
 

• Find the .svg file that was created in the previous step. Open it with a plain text editor or 
a code editor by right clicking on the file and choosing a program from the list of options 
in "Open With." It doesn't matter what you use - as long as you can get at the raw SVG 
output. 
 

• You should see a soup of dense XML markup with lots of numbers. Copy the content of 
the entire document to the clipboard. 

 
• Go back to the Neatline editor and click on the Enter Markup link next to the Draw 

SVG option. 
 

• Paste the SVG markup into the "SVG" box. 
 

• Optionally, set a custom "Density" value. This field controls the number of points that 
Neatline will generate when converting SVG <path> elements to hard-coded spatial 

http://www.adobe.com/products/illustrator.html
http://inkscape.org/
http://wiki.inkscape.org/wiki/index.php/Inkscape_for_Adobe_Illustrator_users


coordinates - low numbers produce "blocky" shapes, high numbers produce "smooth" 
shapes. 
 

• Click Parse. Behind the scenes, Neatline converts the SVG markup into geospatial 
coordinates. 

 
• Now, you can drag the SVG document onto the map in the same way that you would 

drag out a regular polygon shape. Move the cursor to the location on the map where you 
want the bottom left corner of the illustration to be location, click down, and move the 
cursor in any direction. The illustration will scale and rotate according to the position of 
the mouse. 

 
• When the illustration is positioned correctly, release the mouse button to lock the 

geometry into place. 
>Tip: It's easy to make mistakes when doing this, and it often takes a couple tries to get 
things right. If you mess up, it's easiest to totally wipe out the previous attempt by 
clicking the "Clear all Geometry" button at the bottom of the form. 

 
You can edit the color and line weight of your annotation marks. For example you may want to 
make the annotation transparent until the user mouses over it. 



 

Fill Color 
The color of the "body" of 
points and polygons on the 
map - the area inside the 
lines, not including the lines 
themselves. This value is also 
used as a default color for the 
record in other contexts. For 
example, if the record has 
date information, the fill color 
is used to render the point or 
span that represents the 
record on the timeline. 

 
      
     

      
      

     
    
     

Fill Color (Selected) 
The color of the "body" 
of points and polygons 
on the map (inside the 
lines, not including the 
lines themselves) when 
the record is 
highlighted or 
selected - for example, 
when the cursor hovers 
or clicks on the shape. 
To change the color, 
click on the input and 
use the color-picker 
widget to select a new 
color. As you edit the 
value, the record's 
geometry on the map 
will automatically 
update to preview the 
new color  
 

Stroke Color 
The color of the lines that 
run around the edges of 
shapes on the map. 
To change the color, click 
on the input and use the 
color-picker widget to 
select a new color. As you 
edit the value, the record's 
geometry on the map will 
automatically update to 
preview the new color. 

Stroke Color 
(Selected) 
The color of the 
lines that run around 
the edges of shapes 
on the map when 
the record is 
highlighted or 
selected - for 
example, when the 
cursor hovers or 
clicks on the shape. 
To change the color, 
click on the input 
and use the color-
picker widget to 
select a new color. 
As you edit the 
value, the record's 
geometry on the 
map will 
automatically update 
to preview the new 
color. 



• Once you have saved, click the "X” to the right of your record’s title. The record is now 
saved to the map with whatever info you put in it. If you want to edit the record, find and 
click your record’s title under "New Record" and the record settings will pop up. 
 

Preview Your Neatline 
 

• From the Neatline Editor, click "Back to Omeka". 
 

• Beneath your Neatline’s title, click "Public View" to display what the exhibit looks like on 
the public website. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



GUIDE TO NEATLINE’S SIMILE TIMELINE 
Neatline has two very useful widgets (additional plugins, which must be downloaded and 
activated separately): Waypoints and the SIMILE Timeline. The SIMILE Timeline widget allows 
users to add interactive timeline components to Neatline exhibits. 
 
Add SIMILE Timeline to your exhibit under ‘Exhibit Settings.’

 

 
 
Navigate to the edit page of your Neatline exhibit and customize default settings for the SIMILE 
Timeline plugin. 

  

Default Date: 
The date you want the timeline to automatically open to. 
 
Interval Unit: 
Choose any measure of time from seconds to millennia.  
 
*The other fields refer to the sizes of intervals and records 

          
 



In order to link a Neatline record to the SIMILE Timeline, it is necessary to activate the widget 
for each new record (the same is true for Neatline Waypoints). 

  

 
 

 
 
 

 
 
 
 
 
 

The colors you 
choose for 
geometries on the 
Neatline map will 
also be reflected on 
the SIMILE timeline. 

Set the temporal span for each record on the timeline by selecting start 
and end dates for each event. (Enter dates in the YYYY-MM-DD 
format.) 
 
*For BCE dates, add two zeros before the year. (Example: -001563-04-
23 represents April 23, 1564 BCE) 
 
*If your timeline tracks events to the hour, minute or second, enter dates 
in the YYYY-MM-DDTHH:MM:SS format. (T alerts Neatline that a time 
value follows. Example: 1564-04-23T08:30:15 refers to 15 seconds after 
8:30am on April 23, 1564.) 
 
After and Before dates determine the duration of the geometries and 
Waypoint linked to each individual record, based on the position of the 
timeline. (For example, a record with an After Date of 1458-06-15 and a 
Before date of 1495-01-20 will only be visible when the center line of the 

           
            



GUIDE TO NEATLINE WAYPOINTS 
The Neatline Waypoints widget allows the creation of contextual reference points for exhibit 
content, providing creators a means of shaping users' interaction with the exhibit's contents. 
 
To use to Waypoint function you must first enable the waypoint widget. On the exhibit settings 
screen, select the widget from the dropdown menu.  

 

 
 
 

To include a Neatline record on the waypoints sidebar move from editing the exhibit settings to 
editing the actual Neatline: 

• Create the Neatline record 
• On the Style tab of the record, click the Widgets field and select Waypoints from the drop 

down box. (MAKE SURE TO SAVE THE RECORD!) 
 

 
 
 
 
 
 
 
 
 

 



 
Editing Waypoints:  
To access settings for the Waypoint widget, from the main Neatline editor screen, click on the 
Plugins tab, then select Waypoints from the list. After opening the Waypoints setting tab, you 
can click and drag your waypoints into the desired order then save your changes by clicking the 
blue “Save” button. The new order of your waypoints will display on the waypoints sidebar once 
you've saved your changes. 
 

 
 

 
 
 


